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Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the Power Control Library (PCLIB) for the family of
DSP56800EX core-based digital signal controllers. This library contains optimized
functions.

1.1.2 Data types

PCLIB supports several data types: (un)signed integer, fractional, and accumulator. The
integer data types are useful for general-purpose computation; they are familiar to the
MPU and MCU programmers. The fractional data types enable powerful numeric and
digital-signal-processing algorithms to be implemented. The accumulator data type is a
combination of both; that means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

• Unsigned 16-bit integer —<0 ; 65535> with the minimum resolution of 1
• Signed 16-bit integer —<-32768 ; 32767> with the minimum resolution of 1
• Unsigned 32-bit integer —<0 ; 4294967295> with the minimum resolution of 1
• Signed 32-bit integer —<-2147483648 ; 2147483647> with the minimum resolution

of 1

The following list shows the fractional types defined in the libraries:

• Fixed-point 16-bit fractional —<-1 ; 1 - 2-15> with the minimum resolution of 2-15

• Fixed-point 32-bit fractional —<-1 ; 1 - 2-31> with the minimum resolution of 2-31
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The following list shows the accumulator types defined in the libraries:

• Fixed-point 16-bit accumulator —<-256.0 ; 256.0 - 2-7> with the minimum
resolution of 2-7

• Fixed-point 32-bit accumulator —<-65536.0 ; 65536.0 - 2-15> with the minimum
resolution of 2-15

1.1.3 API definition

PCLIB uses the types mentioned in the previous section. To enable simple usage of the
algorithms, their names use set prefixes and postfixes to distinguish the functions'
versions. See the following example:

f32Result = MLIB_Mac_F32lss(f32Accum, f16Mult1, f16Mult2);

where the function is compiled from four parts:

• MLIB—this is the library prefix
• Mac—the function name—Multiply-Accumulate
• F32—the function output type
• lss—the types of the function inputs; if all the inputs have the same type as the

output, the inputs are not marked

The input and output types are described in the following table:

Table 1-1. Input/output types

Type Output Input

frac16_t F16 s

frac32_t F32 l

acc32_t A32 a

1.1.4 Supported compilers
PCLIB for the DSP56800EX core is written in assembly language with C-callable
interface. The library is built and tested using the following compilers:

• CodeWarrior™ Development Studio

For the CodeWarrior™ Development Studio, the library is delivered in the pclib.lib file.

Introduction
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The interfaces to the algorithms included in this library are combined into a single public
interface include file, pclib.h. This is done to lower the number of files required to be
included in your application.

1.1.5 Library configuration

1.1.6 Special issues
1. The equations describing the algorithms are symbolic. If there is positive 1, the

number is the closest number to 1 that the resolution of the used fractional type
allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions require the core saturation mode to be turned off, otherwise the
results can be incorrect. Several specific library functions are immune to the setting
of the saturation mode.

3. The library functions round the result (the API contains Rnd) to the nearest (two's
complement rounding) or to the nearest even number (convergent round). The mode
used depends on the core option mode register (OMR) setting. See the core manual
for details.

4. All non-inline functions are implemented without storing any of the volatile registers
(refer to the compiler manual) used by the respective routine. Only the non-volatile
registers (C10, D10, R5) are saved by pushing the registers on the stack. Therefore, if
the particular registers initialized before the library function call are to be used after
the function call, it is necessary to save them manually.

1.2 Library integration into project (CodeWarrior™
Development Studio)

This section provides a step-by-step guide to quickly and easily integrate the PCLIB into
an empty project using CodeWarrior™ Development Studio. This example uses the
MC56F84789 part, and the default installation path (C:\NXP\RTCESL
\DSP56800EX_RTCESL_4.5) is supposed. If you have a different installation path, you
must use that path instead.

Chapter 1 Library
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1.2.1 New project
To start working on an application, create a new project. If the project already exists and
is open, skip to the next section. Follow the steps given below to create a new project.

1. Launch CodeWarrior™ Development Studio.
2. Choose File > New > Bareboard Project, so that the "New Bareboard Project" dialog

appears.
3. Type a name of the project, for example, MyProject01.
4. If you don't use the default location, untick the “Use default location” checkbox, and

type the path where you want to create the project folder; for example, C:
\CWProjects\MyProject01, and click Next. See Figure 1-1.

Figure 1-1. Project name and location
5. Expand the tree by clicking the 56800/E (DSC) and MC56F84789. Select the

Application option and click Next. See Figure 1-2.

Library integration into project (CodeWarrior™ Development Studio)
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Figure 1-2. Processor selection
6. Now select the connection that will be used to download and debug the application.

In this case, select the option P&E USB MultiLink Universal[FX] / USB MultiLink
and Freescale USB TAP, and click Next. See Figure 1-3.

Figure 1-3. Connection selection
7. From the options given, select the Simple Mixed Assembly and C language, and

click Finish. See Figure 1-4.

Figure 1-4. Language choice

Chapter 1 Library
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The new project is now visible in the left-hand part of CodeWarrior™ Development
Studio. See Figure 1-5.

Figure 1-5. Project folder

1.2.2 Library path variable

To make the library integration easier, create a variable that will hold the information
about the library path.

1. Right-click the MyProject01 node in the left-hand part and click Properties, or select
Project > Properties from the menu. The project properties dialog appears.

2. Expand the Resource node and click Linked Resources. See Figure 1-6.

Library integration into project (CodeWarrior™ Development Studio)
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Figure 1-6. Project properties
3. Click the 'New…' button on the right-hand side.
4. In the dialog that appears (see Figure 1-7), type this variable name into the Name

box: RTCESL_LOC
5. Select the library parent folder by clicking 'Folder…' or just typing the following

path into the Location box: C:\NXP\RTCESL\DSP56800EX_RTCESL_4.5_CW and
click OK.

6. Click OK in the previous dialog.

Chapter 1 Library
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Figure 1-7. New variable

1.2.3 Library folder addition

To use the library, add it into the CodeWarrior Project tree dialog.

1. Right-click the MyProject01 node in the left-hand part and click New > Folder, or
select File > New > Folder from the menu. A dialog appears.

2. Click Advanced to show the advanced options.
3. To link the library source, select the third option—Link to alternate location (Linked

Folder).
4. Click Variables…, and select the RTCESL_LOC variable in the dialog that appears,

click OK, and/or type the variable name into the box. See Figure 1-8.
5. Click Finish, and you will see the library folder linked in the project. See Figure 1-9

Library integration into project (CodeWarrior™ Development Studio)

PCLIB User's Guide, Rev. 4, 05/2019

12 NXP Semiconductors



Figure 1-8. Folder link

Figure 1-9. Projects libraries paths

1.2.4 Library path setup
1. Right-click the MyProject01 node in the left-hand part and click Properties, or select

Project > Properties from the menu. A dialog with the project properties appears.
2. Expand the C/C++ Build node, and click Settings.
3. In the right-hand tree, expand the DSC Linker node, and click Input. See Figure 1-11.
4. In the third dialog Additional Libraries, click the 'Add…' icon, and a dialog appears.

Chapter 1 Library
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5. Look for the RTCESL_LOC variable by clicking Variables…, and then finish the
path in the box by adding one of the following:

• ${RTCESL_LOC}\MLIB\mlib_SDM.lib—for small data model projects
• ${RTCESL_LOC}\MLIB\mlib_LDM.lib—for large data model projects

6. Tick the box Relative To, and select RTCESL_LOC next to the box. See Figure 1-9.
Click OK.

7. Look for the RTCESL_LOC variable by clicking Variables…, and then finish the
path in the box by adding one of the following:

• ${RTCESL_LOC}\PCLIB\pclib_SDM.lib—for small data model projects
• ${RTCESL_LOC}\PCLIB\pclib_LDM.lib—for large data model projects

8. Now, you will see the added in the box. See Figure 1-11.

Figure 1-10. Library file inclusion

Library integration into project (CodeWarrior™ Development Studio)
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Figure 1-11. Linker setting
9. In the tree under the DSC Compiler node, click Access Paths.

10. In the Search User Paths dialog (#include “…”), click the 'Add…' icon, and a dialog
will appear.

11. Look for the RTCESL_LOC variable by clicking Variables…, and then finish the
path in the box to be: ${RTCESL_LOC}\MLIB\include.

12. Tick the box Relative To, and select RTCESL_LOC next to the box. See Figure
1-12. Click OK.

13. Look for the RTCESL_LOC variable by clicking Variables…, and then finish the
path in the box to be: ${RTCESL_LOC}\PCLIB\include.

14. Now you will see the added in the box. See Figure 1-13. Click OK.

Chapter 1 Library
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Figure 1-12. Library include path addition

Figure 1-13. Compiler setting

The final step is typing the #include syntax into the code. Include the library into the
main.c file. In the left-hand dialog, open the Sources folder of the project, and double-
click the main.c file. After the main.c file opens up, include the following lines into the
#include section:

#include "mlib.h"
#include "pclib.h"

When you click the Build icon (hammer), the project will be compiled without errors.

Library integration into project (CodeWarrior™ Development Studio)
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Chapter 2
Algorithms in detail

2.1 PCLIB_Ctrl2P2Z

The PCLIB_Ctrl2P2Z function calculates the compensation block for the controller,
which consists of two poles and two zeroes. The s-domain transfer function equation for
two-pole two-zero control law is as follows:

Equation 1.

where y[s] is the output, and x[s] is the input to the system. This control law has two
poles (P1 and P2) and two zeroes (Z1 and Z2). The value or the placement of these poles
and zeroes in the bode plot affects the stability and performance of the control loop and
the system. The z-domain controller Gc(z) at sampling time Ts is expressed using the
Tustin method as follows:

Equation 2.

Equation 3.

where:

• y[t] = y[n] is the present output
• y[t] · z -1 = y[n-1] is the previous output
• y[t] · z -2 = y[n-2] is the previous to previous output
• x[t] = x[n] is the present error
• x[t] · z -1 = x[n-1] is the previous error
• x[t] · z -2 = x[n-2] is the previous to previous error
• b0, b1, b2, a1, and a2 are the control coefficients and functions of Z1, Z2, P1, P2,

and sampling time Ts.
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Equation 4.

For a proper use of this function, it is recommended to initialize the function's data by the
PCLIB_Ctrl2P2ZInit function, before using the function. This function clears the internal
buffers of the 2P2Z controller. You must call this function when you want the 2P2Z
controller to be initialized. The init function must not be called together with
PCLIB_Ctrl2P2Z, unless a periodic clearing of buffers is required.

2.1.1 Available versions

The available versions of the PCLIB_Ctrl2P2ZInit function are shown in the following
table:

Table 2-1. Init function versions

Function name Input type Parameters Result type

PCLIB_Ctrl2P2ZInit_F16 frac16_t PCLIB_CTRL_2P2Z_T_F16 * void

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters
structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_Ctrl2P2Z function are shown in the following table:

Table 2-2. Function versions

Function name Input type Parameters Result type

PCLIB_Ctrl2P2Z_F16 frac16_t PCLIB_CTRL_2P2Z_T_F16 * frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to
by an input pointer. The function returns a 16-bit fractional value in the range <-1 ; 1).

2.1.2 PCLIB_CTRL_2P2Z_T_F16

Variable name Type Description

f16CoeffB0 frac16_t Control coefficient for the present error. The parameter is a 16-bit fractional value within
the range <-1 ; 1). Set by the user.

f16CoeffB1 frac16_t Control coefficient for the past error. The parameter is a 16-bit fractional value within the
range <-1 ; 1). Set by the user.

f16CoeffB2 frac16_t Control coefficient for the past to past error. The parameter is a 16-bit fractional value
within the range <-1 ; 1). Set by the user.

f16CoeffA1 frac16_t Control coefficient for the past result. The parameter is a 16-bit fractional value within
the range <-1 ; 1). Set by the user.

Table continues on the next page...

PCLIB_Ctrl2P2Z
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Variable name Type Description

f16CoeffA2 frac16_t Control coefficient for the past to past result. The parameter is a 16-bit fractional value
within the range <-1 ; 1). Set by the user.

f16DelayX1 frac16_t Delay parameter for the past error. Controlled by the algorithm.

f16DelayX2 frac16_t Delay parameter for the past to past error. Controlled by the algorithm.

f16DelayY1 frac16_t Delay parameter for the past result. Controlled by the algorithm.

f16DelayY2 frac16_t Delay parameter for the past to past result. Controlled by the algorithm.

2.1.3 Declaration

The available PCLIB_Ctrl2P2Z functions have the following declarations:

void PCLIB_Ctrl2P2ZInit_F16(PCLIB_CTRL_2P2Z_T_F16 *psParam)  
frac16_t PCLIB_Ctrl2P2Z_F16(frac16_t f16InErr, PCLIB_CTRL_2P2Z_T_F16 *psParam)

2.1.4 Function use

The use of the PCLIB_Ctrl2P2ZInit_F16 and PCLIB_Ctrl2P2Z functions is shown in the
following example:

#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_2P2Z_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16CoeffB0 = FRAC16(0.1);    
    sParam.f16CoeffB1 = FRAC16(0.2);
    sParam.f16CoeffB2 = FRAC16(0.15);       
    sParam.f16CoeffA1 = FRAC16(0.1);
    sParam.f16CoeffA2 = FRAC16(0.25);       
    
    PCLIB_Ctrl2P2ZInit_F16(&sParam);
}

/* Periodical function or interrupt */
void Isr()
{
   f16Result = PCLIB_Ctrl2P2Z_F16(f16InErr, &sParam); 
}

2.2 PCLIB_Ctrl3P3Z

Chapter 2 Algorithms in detail
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The PCLIB_Ctrl3P3Z function calculates the compensation block for the controller,
which consists of three poles and three zeroes. The s-domain transfer function equation
for the three-pole three-zero control law is as follows:

Equation 5.

where y[s] is the output and x[s] is the input to the system. This control law has three
poles (P1, P2, and P3) and three zeroes (Z1, Z2, and Z3). The value or the placement of
these poles and zeroes in the bode plot affects the stability and performance of the control
loop and the system. The z-domain controller Gc(z) at sampling time Ts is expressed
using the Tustin method as follows:

Equation 6.

Equation 7.

where:

• y[t] = y[n] is the present output
• y[t] · z -1 = y[n-1] is the previous output
• y[t] · z -2 = y[n-2] is the previous to previous output
• y[t] · z -3 = y[n-3] is the previous to previous to previous output
• x[t] = x[n] is the present error
• x[t] · z -1 = x[n-1] is the previous error
• x[t] · z -2 = x[n-2] is the previous to previous error
• x[t] · z -3 = x[n-3] is the previous to previous to previous error
• b0, b1, b2, b3 a1, a2, and a3 are the control coefficients and functions of Z1, Z2, Z3,

P1, P2, P3, and sampling time Ts.

Equation 8.

For a proper use of this function, it is recommended to initialize the function's data by the
PCLIB_Ctrl3P3ZInit function, before using the function. This function clears the internal
buffers of the 3P3Z controller. You must call this function when you want the 3P3Z
controller to be initialized. The init function must not be called together with
PCLIB_Ctrl3P3Z, unless a periodic clearing of buffers is required.

PCLIB_Ctrl3P3Z
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2.2.1 Available versions

The available versions of the PCLIB_Ctrl3P3ZInit function are shown in the following
table:

Table 2-3. Init function versions

Function name Input type Parameters Result type

PCLIB_Ctrl3P3ZInit_F16 frac16_t PCLIB_CTRL_3P3Z_T_F16 * void

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters
structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_Ctrl3P3Z function are shown in the following table:

Table 2-4. Function versions

Function name Input type Parameters Result type

PCLIB_Ctrl3P3Z_F16 frac16_t PCLIB_CTRL_3P3Z_T_F16 * frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to
by an input pointer. The function returns a 16-bit fractional value in the range <-1 ; 1).

2.2.2 PCLIB_CTRL_3P3Z_T_F16

Variable name Input type Description

f16CoeffB0 frac16_t Control coefficient for the present error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffB1 frac16_t Control coefficient for the past error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffB2 frac16_t Control coefficient for the past to past error. The parameter is a 16-bit
fractional value within the range <-1 ; 1). Set by the user.

f16CoeffB3 frac16_t Control coefficient for the past to past to past error. The parameter is a 16-
bit fractional value within the range <-1 ; 1). Set by the user.

f16CoeffA1 frac16_t Control coefficient for the past result. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffA2 frac16_t Control coefficient for the past to past result. The parameter is a 16-bit
fractional value within the range <-1 ; 1). Set by the user.

f16CoeffA3 frac16_t Control coefficient for the past to past to past result. The parameter is a 16-
bit fractional value within the range <-1 ; 1). Set by the user.

f16DelayX1 frac16_t Delay parameter for the past error. Controlled by the algorithm.

f16DelayX2 frac16_t Delay parameter for the past to past error. Controlled by the algorithm.

f16DelayX3 frac16_t Delay parameter for the past to past to past error. Controlled by the
algorithm.

f16DelayY1 frac16_t Delay parameter for the past result. Controlled by the algorithm.

f16DelayY2 frac16_t Delay parameter for the past to past result. Controlled by the algorithm.

Table continues on the next page...
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Variable name Input type Description

f16DelayY3 frac16_t Delay parameter for the past to past to past result. Controlled by the
algorithm.

2.2.3 Declaration

The available PCLIB_Ctrl3P3Z functions have the following declarations:

void PCLIB_Ctrl3P3ZInit_F16(PCLIB_CTRL_3P3Z_T_F16 *psParam)  
frac16_t PCLIB_Ctrl3P3Z_F16(frac16_t f16InErr, PCLIB_CTRL_3P3Z_T_F16 *psParam)

2.2.4 Function use

The use of the PCLIB_Ctrl3P3ZInit_F16 and PCLIB_Ctrl3P3Z functions is shown in the
following example:

#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_3P3Z_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16CoeffB0 = FRAC16(0.1);    
    sParam.f16CoeffB1 = FRAC16(0.2);
    sParam.f16CoeffB2 = FRAC16(0.15);       
    sParam.f16CoeffB3 = FRAC16(0.12);       
    sParam.f16CoeffA1 = FRAC16(0.1);
    sParam.f16CoeffA2 = FRAC16(0.25);       
    sParam.f16CoeffA3 = FRAC16(0.35);       
    
    PCLIB_Ctrl3P3ZInit_F16(&sParam);
}

/* Periodical function or interrupt */
void Isr()
{
   f16Result = PCLIB_Ctrl3P3Z_F16(f16InErr, &sParam); 
}

2.3 PCLIB_CtrlPI

PCLIB_CtrlPI
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The PCLIB_CtrlPI function calculates the Proportional-Integral (PI) compensation block
for any given control system in power-control and motor-control applications. The
integral output of the controller is also limited, and the limit values (IntegralUpperLimit
and IntegralLowerLimit) are defined by the user. The controller output is also limited,
and the limit values (UpperLimit and LowerLimit) are defined by the user. The integral
state is limited by the controller limits in the same way as the controller output.

The PI algorithm in the continuous time domain is expressed as follows:

Equation 9.

The above equation can be rewritten into the discrete time domain by approximating the
integral term. The integral term is approximated by the Backward Euler method, also
known as backward rectangular or right-hand approximation, as follows:

Equation 10.

The discrete time domain representation of the PI algorithms is as follows:

Equation 11.

where:

• e(n) is the input error
• y(n) is the controller output
• Kp is the proportional gain
• Ki is the integral gain
• yI(n-1) is the previous integral output
• Ts is the sampling time

Rewritten as follows:

Equation 12.

Equation 13.
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For a proper use of this function, it is recommended to initialize the function's data by the
PCLIB_CtrlPIInit functions, before using this function. This function clears the internal
buffers of a PI controller. You must call this function when you want the PI controller to
be initialized. The init function must not be called together with PCLIB_CtrlPI, unless a
periodic clearing of buffers is required.

2.3.1 Available versions

The available versions of the PCLIB_CtrlPIInit function are shown in the following table:

Table 2-5. Init function versions

Function name Input type Parameters Result type

PCLIB_CtrlPIInit_F16 frac16_t PCLIB_CTRL_PI_T_F16 * void

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters
structure. It clears the internal integral accumulator buffer.

The available versions of the PCLIB_CtrlPI function are shown in the following table:

Table 2-6. Function versions

Function name Input type Parameters Result type

PCLIB_CtrlPI_F16 frac16_t PCLIB_CTRL_PI_T_F16 * frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to
by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLimit ;
f16UpperLimit>.

2.3.2 PCLIB_CTRL_PI_T_F16

Variable name Input type Description

f16Kp frac16_t Proportional gain. The parameter is a 16-bit fractional value within the range <-1 ; 1).
Set by the user.

f16Ki frac16_t Integral gain. The parameter is a 16-bit fractional value within the range <-1 ; 1). Set by
the user.

f16PreviousIntegralOut
put

frac16_t Internal integral accumulator. Controlled by the algorithm.

f16IntegralUpperLimit frac16_t Upper limit of the the integral accumulator. These parameters must be greater than
f16IntegralLowerLimit. Set by the user.

f16IntegralLowerLimit frac16_t Lower limit of the the integral accumulator. These parameters must be lower than
f16IntegralUpperLimit. Set by the user.

f16UpperLimit frac16_t Upper limit of the the controller's output. These parameters must be greater than
f16LowerLimit. Set by the user.

Table continues on the next page...
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Variable name Input type Description

f16LowerLimit frac16_t Lower limit of the the controller's output. These parameters must be lower than
f16UpperLimit. Set by the user.

2.3.3 Declaration

The available PCLIB_CtrlPI functions have the following declarations:

void PCLIB_CtrlPIInit_F16(PCLIB_CTRL_PI_T_F16 *psParam)  
frac16_t PCLIB_CtrlPI_F16(frac16_t f16InErr, PCLIB_CTRL_PI_T_F16 *psParam)

2.3.4 Function use

The use of the PCLIB_CtrlPIInit_F16 and PCLIB_CtrlPI functions is shown in the
following example:

#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PI_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16Kp = FRAC16(0.1);    
    sParam.f16Ki = FRAC16(0.2);
    sParam.f16IntegralUpperLimit = FRAC16(0.9);
    sParam.f16IntegralLowerLimit = FRAC16(-0.9);         
    sParam.f16UpperLimit = FRAC16(0.9);
    sParam.f16LowerLimit = FRAC16(-0.9);         
    
    PCLIB_CtrlPIInit_F16(&psParam);
}

/* Periodical function or interrupt */
void Isr()
{
   f16Result = PCLIB_CtrlPI_F16(f16InErr, &sParam); 
}

2.4 PCLIB_CtrlPIandLPFilter
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The PCLIB_CtrlPIandLPFilter function calculates the Proportional-Integral (PI)
compensation block, along with the low-pass filter. The low-pass filter's pole and zero are
placed at much higher frequency to compensate for the output capacitor ESR. It can be
represented as follows:

Equation 14.

It increases the system performance even at the high frequency (in bode plot frequency
domain) of system operations. This is equivalent to:

Equation 15.

where y[s] is the output, and x[s] is the input to the system. This control law has two
poles (P1 and P2) and two zeroes (Z1 and Z2). The value or the placement of these poles
and zeroes in the bode plot influence the stability and performance of the control loop
and the system. The z-domain controller Gc(z) at sampling time Ts is expressed using the
Tustin method as follows:

Equation 16.

Equation 17.

where:

• y[t] = y[n] is the present output
• y[t] · z -1 = y[n-1] is the previous output
• y[t] · z -2 = y[n-2] is the previous to previous output
• x[t] = x[n] is the present error
• x[t] · z -1 = x[n-1] is the previous error
• x[t] · z -2 = x[n-2] is the previous to previous error
• b0, b1, b2, a1, and a2 are the control coefficients and functions of Z1, Z2, P1, P2,

and sampling time Ts.

Equation 18.
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For a proper use of this function, it is recommended to initialize the function's data by the
PCLIB_CtrlPIandLPInit functions, before using the function. This function clears the
internal buffers of the PIandLP controller. You must call this function when you want the
PIandLP controller to be initialized. The init function must not be called together with
PCLIB_CtrlPIandLPFilter, unless a periodic clearing of buffers is required.

2.4.1 Available versions

The available versions of the PCLIB_CtrlPIandLPInit function are shown in the
following table:

Table 2-7. Init function versions

Function name Input type Parameters Result type

PCLIB_CtrlPIandLPInit_F16 frac16_t PCLIB_CTRL_PI_LP_T_F16 * void

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters
structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_CtrlPIandLPFilter function are shown in the
following table:

Table 2-8. Function versions

Function name Input type Parameters Result type

PCLIB_CtrlPIandLP_F16 frac16_t PCLIB_CTRL_PI_LP_T_F16 * frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to
by an input pointer. The function returns a 16-bit fractional value in the range <-1 ; 1).

2.4.2 PCLIB_CTRL_PI_LP_T_F16

Variable name Input type Description

f16CoeffB0 frac16_t Control coefficient for the present error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffB1 frac16_t Control coefficient for the past error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffB2 frac16_t Control coefficient for the past to past error. The parameter is a 16-bit
fractional value within the range <-1 ; 1). Set by the user.

f16CoeffA1 frac16_t Control coefficient for the past result. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16CoeffA2 frac16_t Control coefficient for the past to past result. The parameter is a 16-bit
fractional value within the range <-1 ; 1). Set by the user.

Table continues on the next page...
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Variable name Input type Description

f16DelayX1 frac16_t Delay parameter for the past error. Controlled by the algorithm.

f16DelayX2 frac16_t Delay parameter for the past to past error. Controlled by the algorithm.

f16DelayY1 frac16_t Delay parameter for the past result. Controlled by the algorithm.

f16DelayY2 frac16_t Delay parameter for the past to past result. Controlled by the algorithm.

2.4.3 Declaration

The available PCLIB_CtrlPIandLPFilter functions have the following declarations:

void PCLIB_CtrlPIandLPInit_F16(PCLIB_CTRL_PI_LP_T_F16 *psParam)  
frac16_t PCLIB_CtrlPIandLP_F16(frac16_t f16InErr, PCLIB_CTRL_PI_LP_T_F16 *psParam)

2.4.4 Function use

The use of the PCLIB_CtrlPIandLPInit_F16 and PCLIB_CtrlPIandLPFilter functions is
shown in the following example:

#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PI_LP_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16CoeffB0 = FRAC16(0.1);    
    sParam.f16CoeffB1 = FRAC16(0.2);
    sParam.f16CoeffB2 = FRAC16(0.15);       
    sParam.f16CoeffA1 = FRAC16(0.1);
    sParam.f16CoeffA2 = FRAC16(0.25);       
    
    PCLIB_CtrlPIandLPInit_F16(&sParam);
}

/* Periodical function or interrupt */
void Isr()
{
   f16Result = PCLIB_CtrlPIandLP_F16(f16InErr, &sParam); 
}

2.5 PCLIB_CtrlPID

PCLIB_CtrlPID
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The PCLIB_CtrlPID function calculates the Proportional-Integral-Derivative (PID)
algorithm, according to the proportional (Kp), integral (Ki), and differential (Kd)
coefficients. The controller output is limited, and you can define the limit values.

The PID algorithm in the continuous time domain is expressed as follows:

Equation 19.

where:

• e(t) is the input error in the continuous time domain
• y(t) is the controller output in the continuous time domain
• Kp is the proportional coefficient
• Ki is the integral coefficient
• Kd is the differential coefficient

It can be rewritten as:

Equation 20.

Equation 21.

Equation 22.

Equation 23.

It can be further simplified as:

Kp+Ki+Kd=KA

-Kp-2Kd=KB

Kd=KC

therefore:

Equation 24.
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Equation 25.

Equation 26.

where:

• y(t) = y[n] is the present output
• y(t) · z -1 = y[n-1] is the previous output
• x(t) = x[n] is the present error
• x(t) · z -1 = x[n-1] is the previous error
• x(t) · z -2 = x[n-2] is the previous to previous error

For a proper use of this function, it is recommended to initialize the function's data by the
PCLIB_CtrlPIDInit functions, before using this function. This function clears the internal
buffers of the PID controller. You must call this function when you want the PID
controller to be initialized. The init function must not be called together with
PCLIB_CtrlPID, unless a periodic clearing of buffers is required.

2.5.1 Available versions

The available versions of the PCLIB_CtrlPIDInit function are shown in the following
table:

Table 2-9. Init function versions

Function name Input type Parameters Result type

PCLIB_CtrlPIDInit_F16 frac16_t PCLIB_CTRL_PID_T_F16 * void

The inputs are a 16-bit fractional initial value and a pointer to the controller parameters'
structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_CtrlPID function are shown in the following table:

Table 2-10. Function versions

Function name Input type Parameters Result type

PCLIB_CtrlPID_F16 frac16_t PCLIB_CTRL_PID_T_F16 * frac16_t

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to
by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLimit ;
f16UpperLimit>.

PCLIB_CtrlPID
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2.5.2 PCLIB_CTRL_PID_T_F16

Variable name Input type Description

f16Ka frac16_t Control coefficient for the present error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16Kb frac16_t Control coefficient for the past error. The parameter is a 16-bit fractional
value within the range <-1 ; 1). Set by the user.

f16Kc frac16_t Control coefficient for the past to past error. The parameter is a 16-bit
fractional value within the range <-1 ; 1). Set by the user.

f16DelayX1 frac16_t Delay parameter for the past error. Controlled by the algorithm.

f16DelayX2 frac16_t Delay parameter for the past to past error. Controlled by the algorithm.

f16DelayY1 frac16_t Delay parameter for the past result. Controlled by the algorithm.

f16UpperLimit frac16_t Upper limit of the controller's output. This parameter must be greater than
f16LowerLimit. Set by the user.

f16LowerLimit frac16_t Lower limit of the controller's output. This parameter must be lower than
f16UpperLimit. Set by the user.

2.5.3 Declaration

The available PCLIB_CtrlPID functions have the following declarations:

void PCLIB_CtrlPIDInit_F16(PCLIB_CTRL_PID_T_F16 *psParam)  
frac16_t PCLIB_CtrlPID_F16(frac16_t f16InErr, PCLIB_CTRL_PID_T_F16 *psParam)

2.5.4 Function use

The use of the PCLIB_CtrlPIDInit_F16 and PCLIB_CtrlPID functions is shown in the
following example:

#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PID_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16Ka = FRAC16(0.1);    
    sParam.f16Kb = FRAC16(0.2);
    sParam.f16Kc = FRAC16(0.15);       
    sParam.f16UpperLimit = FRAC16(0.9);
    sParam.f16LowerLimit = FRAC16(-0.9);         
    
    PCLIB_CtrlPIDInit_F16(&sParam);
}
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/* Periodical function or interrupt */
void Isr()
{
   f16Result = PCLIB_CtrlPID_F16(f16InErr, &sParam); 
}

PCLIB_CtrlPID
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Appendix A
Library types

A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two
states: TRUE (1) or FALSE (0). Its definition is as follows:

typedef unsigned short bool_t;

The following figure shows the way in which the data is stored by this type:

Table A-1. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Unused
Logi
cal

TRUE
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0 0 0 1

FALSE
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within
the range <0 ; 255>. Its definition is as follows:

typedef unsigned char uint8_t;

The following figure shows the way in which the data is stored by this type:
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Table A-2. Data storage

7 6 5 4 3 2 1 0

Value Integer

255
1 1 1 1 1 1 1 1

F F

11
0 0 0 0 1 0 1 1

0 B

124
0 1 1 1 1 1 0 0

7 C

159
1 0 0 1 1 1 1 1

9 F

A.3 uint16_t

The uint16_t type is an unsigned 16-bit integer type. It is able to store the variables
within the range <0 ; 65535>. Its definition is as follows:

typedef unsigned short uint16_t;

The following figure shows the way in which the data is stored by this type:

Table A-3. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Integer

65535
1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

F F F F

5
0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1

0 0 0 5

15518
0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0

3 C 9 E

40768
1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0

9 F 4 0

A.4 uint32_t

uint16_t
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The uint32_t type is an unsigned 32-bit integer type. It is able to store the variables
within the range <0 ; 4294967295>. Its definition is as follows:

typedef unsigned long uint32_t;

The following figure shows the way in which the data is stored by this type:

Table A-4. Data storage

31 24 23 16 15 8 7 0

Value Integer

4294967295 F F F F F F F F

2147483648 8 0 0 0 0 0 0 0

55977296 0 3 5 6 2 5 5 0

3451051828 C D B 2 D F 3 4

A.5 int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the
range <-128 ; 127>. Its definition is as follows:

typedef char int8_t;

The following figure shows the way in which the data is stored by this type:

Table A-5. Data storage

7 6 5 4 3 2 1 0

Value Sign Integer

127
0 1 1 1 1 1 1 1

7 F

-128
1 0 0 0 0 0 0 0

8 0

60
0 0 1 1 1 1 0 0

3 C

-97
1 0 0 1 1 1 1 1

9 F
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A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the
range <-32768 ; 32767>. Its definition is as follows:

typedef short int16_t;

The following figure shows the way in which the data is stored by this type:

Table A-6. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Sign Integer

32767
0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

7 F F F

-32768
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 0 0 0

15518
0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0

3 C 9 E

-24768
1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0

9 F 4 0

A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the
range <-2147483648 ; 2147483647>. Its definition is as follows:

typedef long int32_t;

The following figure shows the way in which the data is stored by this type:

Table A-7. Data storage

31 24 23 16 15 8 7 0

Value S Integer

2147483647 7 F F F F F F F

-2147483648 8 0 0 0 0 0 0 0

55977296 0 3 5 6 2 5 5 0

-843915468 C D B 2 D F 3 4

int16_t

PCLIB User's Guide, Rev. 4, 05/2019

36 NXP Semiconductors



A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within
the range <-1 ; 1). Its definition is as follows:

typedef char frac8_t;

The following figure shows the way in which the data is stored by this type:

Table A-8. Data storage

7 6 5 4 3 2 1 0

Value Sign Fractional

0.99219
0 1 1 1 1 1 1 1

7 F

-1.0
1 0 0 0 0 0 0 0

8 0

0.46875
0 0 1 1 1 1 0 0

3 C

-0.75781
1 0 0 1 1 1 1 1

9 F

To store a real number as frac8_t, use the FRAC8 macro.

A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within
the range <-1 ; 1). Its definition is as follows:

typedef short frac16_t;

The following figure shows the way in which the data is stored by this type:

Table A-9. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Sign Fractional

0.99997
0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

7 F F F

-1.0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Table continues on the next page...

Appendix A Library types

PCLIB User's Guide, Rev. 4, 05/2019

NXP Semiconductors 37



Table A-9. Data storage (continued)

8 0 0 0

0.47357
0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0

3 C 9 E

-0.75586
1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0

9 F 4 0

To store a real number as frac16_t, use the FRAC16 macro.

A.10 frac32_t

The frac32_t type is a signed 32-bit fractional type. It is able to store the variables within
the range <-1 ; 1). Its definition is as follows:

typedef long frac32_t;

The following figure shows the way in which the data is stored by this type:

Table A-10. Data storage

31 24 23 16 15 8 7 0

Value S Fractional

0.9999999995 7 F F F F F F F

-1.0 8 0 0 0 0 0 0 0

0.02606645970 0 3 5 6 2 5 5 0

-0.3929787632 C D B 2 D F 3 4

To store a real number as frac32_t, use the FRAC32 macro.

A.11 acc16_t

The acc16_t type is a signed 16-bit fractional type. It is able to store the variables within
the range <-256 ; 256). Its definition is as follows:

typedef short acc16_t;

The following figure shows the way in which the data is stored by this type:

frac32_t
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Table A-11. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Value Sign Integer Fractional

255.9921875
0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

7 F F F

-256.0
1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

8 0 0 0

1.0
0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0

0 0 8 0

-1.0
1 1 1 1 1 1 1 1 1 0 0 0 0 0 0 0

F F 8 0

13.7890625
0 0 0 0 0 1 1 0 1 1 1 0 0 1 0 1

0 6 E 5

-89.71875
1 1 0 1 0 0 1 1 0 0 1 0 0 1 0 0

D 3 2 4

To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables
within the range <-65536 ; 65536). Its definition is as follows:

typedef long acc32_t;

The following figure shows the way in which the data is stored by this type:

Table A-12. Data storage

31 24 23 16 15 8 7 0

Value S Integer Fractional

65535.999969 7 F F F F F F F

-65536.0 8 0 0 0 0 0 0 0

1.0 0 0 0 0 8 0 0 0

-1.0 F F F F 8 0 0 0

23.789734 0 0 0 B E 5 1 6

-1171.306793 F D B 6 5 8 B C

To store a real number as acc32_t, use the ACC32 macro.
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A.13 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value
of the bool_t type. Its definition is as follows:

#define FALSE    ((bool_t)0)

#include "mlib.h"

static bool_t bVal;

void main(void)
{
  bVal = FALSE;               /* bVal = FALSE */
}

A.14 TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of
the bool_t type. Its definition is as follows:

#define TRUE     ((bool_t)1)

#include "mlib.h"

static bool_t bVal;

void main(void)
{
  bVal = TRUE;               /* bVal = TRUE */
}

A.15 FRAC8

The FRAC8 macro serves to convert a real number to the frac8_t type. Its definition is as
follows:

#define FRAC8(x) ((frac8_t)((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : 0x7F))

The input is multiplied by 128 (=27). The output is limited to the range <0x80 ; 0x7F>,
which corresponds to <-1.0 ; 1.0-2-7>.

FALSE
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#include "mlib.h"

static frac8_t f8Val;

void main(void)
{
  f8Val = FRAC8(0.187);               /* f8Val = 0.187 */
}

A.16 FRAC16

The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is
as follows:

#define FRAC16(x) ((frac16_t)((x) < 0.999969482421875 ? ((x) >= -1 ? (x)*0x8000 : 0x8000) : 
0x7FFF))

The input is multiplied by 32768 (=215). The output is limited to the range <0x8000 ;
0x7FFF>, which corresponds to <-1.0 ; 1.0-2-15>.

#include "mlib.h"

static frac16_t f16Val;

void main(void)
{
  f16Val = FRAC16(0.736);               /* f16Val = 0.736 */
}

A.17 FRAC32

The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is
as follows:

#define FRAC32(x) ((frac32_t)((x) < 1 ? ((x) >= -1 ? (x)*0x80000000 : 0x80000000) : 
0x7FFFFFFF))

The input is multiplied by 2147483648 (=231). The output is limited to the range
<0x80000000 ; 0x7FFFFFFF>, which corresponds to <-1.0 ; 1.0-2-31>.

#include "mlib.h"

static frac32_t f32Val;

void main(void)
{
  f32Val = FRAC32(-0.1735667);               /* f32Val = -0.1735667 */
}
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A.18 ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as
follows:

#define ACC16(x) ((acc16_t)((x) < 255.9921875 ? ((x) >= -256 ? (x)*0x80 : 0x8000) : 0x7FFF))

The input is multiplied by 128 (=27). The output is limited to the range <0x8000 ;
0x7FFF> that corresponds to <-256.0 ; 255.9921875>.

#include "mlib.h"

static acc16_t a16Val;

void main(void)
{
  a16Val = ACC16(19.45627);               /* a16Val = 19.45627 */
}

A.19 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as
follows:

#define ACC32(x) ((acc32_t)((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 
0x80000000) : 0x7FFFFFFF))

The input is multiplied by 32768 (=215). The output is limited to the range
<0x80000000 ; 0x7FFFFFFF>, which corresponds to <-65536.0 ; 65536.0-2-15>.

#include "mlib.h"

static acc32_t a32Val;

void main(void)
{
  a32Val = ACC32(-13.654437);               /* a32Val = -13.654437 */
}

ACC16
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